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Session Objective

- To equip and teach the session leader and team in the skills required to teach
this course.
- To gather together the equipment and materials that will be used in the
course.

Session Outcomes
By the end of this session, you should:

- Be competent in the skills required for animation.
- Have the equipment and materials required for the course, or be aware of
them.
- Be confident in teaching animation to a group of students.

Overview for the Session Instructor
Before teaching others to animate, it is necessary to be able to know how to animate
yourself. Leading an animation course can be quite stressful if ill-prepared; this
session should be done well in advance of the first session with the students, in order
to prepare you and your team for a smooth delivery.The content of this session will be
drawn on throughout the rest of the course so being familiar with this session maybe
very useful.

Once all of the materials and equipment have been prepared, this session will take
about 2 to 3 hours to complete.

Session Outline

Before you Begin
The Theory
Some useful terminology
Setting Up
How to Animate (using the software)
Practice Exercises
The Basics of Editing
Workingwith YoungPeople and Technology: Some Pointers



Before you Begin

Youwill need...

IT Skills A basic knowledge of how to use a computer.

A Team Depending on how many students there are, it is advised
that there is one team member for every 4 students. Extra
hands/helpers are always useful to keep the students on
track and troubleshoot problems.

Youwill also need...

Equipment (per animation set/per 2 to 3 students)

A Camera There are two types of camera that are available to
connect to a PC, which are categorised by the type of
connector that is used to transfer the data from the
camera to the computer. These two types are ‘USB’
(Universal Serial Bus) and ‘Firewire’ (sometimes known as
‘IEEE 1394’ or ‘iLink’).

Firewire (6-pin) USB

USB
USB cameras tend to be used with webcams for internet
conferencing. They are small and relatively inexpensive;
prices range from £10 to £100 pounds. Cheaper cameras
many not have the ability to focus automatically on the
subject being animated; make sure that the camera is in
focus before beginning to animate.

Some schools may have special animation cameras (such
as Digital Blue’s ‘Digital Movie Creator’). These cameras
are recommended over webcams for animating.

The software drivers for a USB camera will need to be
installed in advance of using most USB cameras with a
particular computer. Make sure that there are drivers
available for the operating system on the computer being
used; there are a limited number of USB cameras that
have drivers available for the Mac OS.

Firewire
Generally, Firewire cameras will be better quality than
USB cameras, although they also tend to be a lot more
expensive; prices range from £100 upwards.

A Firewire connector can often be found on digital
camcorders and high-end webcams. It maybe necessary



to use a tripod with Firewire cameras and often a Firewire
cable will need to be purchased separately in order to
make the connection from camera to computer.

Firewire cameras do not need drivers to be installed on
the computer that it is being used with; they generally
work with all operating systems automatically.

A Computer Most computers made in the last 3 years will be suitable to
be used to make an animation. The only condition is that
the computer being used needs to have the appropriate
connector (USB or Firewire) to be able to attach the
camera being used.

Mac vs PC
If possible, it is recommended that Macintosh computers
are used in this course, mainly due to the software
available for them for animating and editing. Most schools
will use Windows based PCs; this course is written to take
into account either a Mac or PC system being used. It is
recommended to use either one or the other system, not
both.

Animation Software The recommended software for this course is Boinx’s
‘iStopMotion’. It costs about £20 and can be purchased
from Boinx’s web site (http://www.istopmotion.com).
Discounts are available for volume licence purchases.

However, this software is only available for Macintosh
computers.

There is alternative software for Windows computers
called SMA (Stop Motion Animator), which is free. This
course has been tested using this software and contains
tutorials for operating it. As the Crux goes to press, SMA is
available to download from:

http://www.animateclay.com/anasazi/smafull.exe

or take a look at the Crux web site for a list of active links
to this software and alternative software.

Video Editing Software ForWindows:
Windows MovieMaker - Comes free with Windows XP and
Vista.

For Mac OS X:
iMovie - Comes free with all new Macs.

A TableTop A working area large enough to accommodate a computer
and some models to move around (about 1m by 2m is
recommended).

Optional:

DVD burner & software Useful for distributing the finished animations.

http://www.animateclay.com/anasazi/smafull.exe


Tripod Maybe required for digital cameras and camcorders.

Desk Lamps Two per set. Desk lamps are recommended for lighting
the sets, especially in poorly lit rooms. Changes in light
within a room are very obvious in animated clips; using
desk lamps will keep the lighting of a scene constant and
also keep the plasticine models warm, soft and easy to
work with.

NOTE: It maybe part of a school’s insurance policy that
equipment used on their premises is PAT tested for
electrical safety. If you are using your own equipment in a
school, ask about this before taking in equipment that has
not been PATtested.

It is recommended that if you are bringing electrical
equipment into schools, that the number of available
electrical sockets in the room in which the animating is
taking place, is checked before hand. It maybe necessary
to bring some 4-way strip-sockets or a mains extension
lead in order to plug in all the required equipment.

Materials & Art Kit

Plasticine Can be bought from art and craft shops, or if you know
well in advance what colours are required, can be
purchased through a school supplier. Suggested basic
colours: Blue, Red, Yellow, Green, Purple, Orange, Black
and White.

Large (A3 or A2) Paper Especially,white, blue and green are very useful.

J-Clothes For cleaning up afterwards.

Felt-Tip Pens

Pencils

Story-boarding Paper Can be downloaded from http://www.thecrux.co.uk

Optional:

Lighting Gel If desk lights are being used, the light produced from them
can look very yellow/orange on camera. This can be
treated by putting a piece of film over the face of the light,
known as a ‘gel’. Gels come in many different colours, and
there are some blue gels available that will cause a
yellow/orange light to look white on camera. These gels
are known as ‘corrective-white’. For more information on
lighting gels, visit http://www.rosco.com/uk/.

Hard case If models are used session after session, it is important to
protect them between. Keep a plastic box to protect the
models. Plasticine doesn’t dry out easily so it isn’t
necessary for the box to be sealed.



Drinking Straws Useful for holding models together.

Scissors

NOTE: Not all of the equipment and materials listed here will be required for every
session; a list of equipment and materials required for any particular session is listed
at the start of that session.



The Theory
Video is a series of consecutive photos being shown rapidly one after another. In the
UK, TV operates at 25 frames (photos) per second. To the eye, this appears as a
smooth motion on the TV, since the human eye has a limit as to how fast it can take in
information.

Animation is the process of taking each of these still images, each one differing
slightly from the next, in order to create a movement in whatever is being animated.

It is literally a matter of taking a photo, moving the subject slightly, taking another
photo, moving it slightly again, and so on, to build up an animated sequence.



Some useful terminology

Resolution A digital image is made up of little blocks called ‘pixels’, each of a
different colour in order to create the image. The number of pixels
that make up an image is known as the resolution. Resolution is
measured in terms of how many pixels wide an image is, against
how many pixels tall it is.

Resolutions are often written in the form:

640 x 480 or 640 by 480

This means the image is 640 pixels high by 480 pixels across.

A digital imagemade up of pixels

Some common resolutions are:

640 x 480 (known as ‘VGA’)
768 x 576 (the resolution of digital video in the UK)
1920 x 1080 (the current highest resolution of Hi-Definition Video)

For animation in the course, it is recommended to use VGA
resolution; 640 x 480.

Frame A single picture in a video. Many frames shown rapidly one after
another make up a video sequence.

FrameRate This is how many images make up every second of footage. UK
Television is broadcast at the equivalent of 25 frames every second.
It is recommended that for this course, a frame rate of 15 frames per
second is used i.e. for every second of animated video footage, 15
photos need to be taken.

Scene An event that occurs in a particular place.

Shot The way that a particular scene is viewed. A scene maybe made up
of several shots, which help the viewer to understand what is
happening in the scene.



Setting Up
This is a general overview for setting up the software and set and to get you going
animating. Depending on the camera and computer being used, some of these steps
may not be necessary.

It is assumed that the camera drivers and animation software is already installed on
the computer being used. Most driver installers will have a step-by-step guide to
installing the software, as do the installers of the recommended animation software in
this course.

1. Setting up the Scene
Before putting together an animation set, it is important that there is an appropriate
work surface available. It is recommended that an area of at least 1m by 2m is
available per set, though the larger the area, the better.

A basic animation set can be put together as follows:

Setting up an animation work area

Positioning of Camera
Depending on the desired effect, the most appropriate camera positioning for an
animation is so that the camera is pointing directly forward (not tilted up or down) and
is at the ‘eye-level’ of the models. If the camera is on a tripod, it maybe necessary to
put the tripod on the floor to achieve the desired height. If the camera is not on a
tripod, place it on the table and rise it up using books or boxes. If the camera is very
light in weight, use tape to stick the camera to the surface it is placed on, to prevent it
moving between photos; changes in camera positioning will be very obvious when an
animation is played back.

If the feature is available, remember to focus the camera on the model. If the camera
is ‘auto-focusing’, remember to check that it is focusing on the model, not the
backdropor something else in the shot.



Positioning of Lights
The animation set shown previously uses two desk lamps to light the models and
backdrop. Each lamp is positioned at about 45˚ either side of the model, and at an
elevation of about 45˚ above the camera. This should create an even wash of light
across the set. When shooting using lights, try not to get prominent shadows in the
camera shot.

Using the camera, check to make sure that the set does not appear over exposed (too
much light causing the camera shot to be ‘washed out’). If this is the case, either
reduce the sensitivity of the camera, or if this is not possible, reduce the power of the
desk lamps by moving them away from the set or placing a ‘neutral density’ gel over
the face of the lamp (see http://www.rosco.com/uk/ for more details).

Traditionally, the best and simplest method of lighting for film is a technique called
‘Three-point lighting’. However, animation sets are usually so small, the method
suggested here works well enough. If more professional results are desired for the
animation, three-point lighting maybe appropriate.

Positioning of Background
The background should be fixed at the back of the set. The distance between the
backdrop and the camera should be sufficient that the models can move around and
be animated while remaining in focus, but not so great that the background does not
fill the entire camera shot. Depending on magnification of the camera, about 0.5 to 1m
should be sufficient.



Backgrounds can be held in place by having the whole set backed up against a wall
and sticking the background to the wall using blue-tac, or by placing a spare table on
it’s end next to the animation set and sticking the background to the surface of that
table.

Positioning of Models
Models can be positioned as close or as far away from the camera as desired.
However, remember that they should remain in focus and remain lit, which may have
some bearing on where the models can be positioned.

NOTE: All of these guidelines for positioning of models, backdrops, cameras and
lamps are suggestions; there is no ‘correct method’, though the previous maybe
helpful. In the end, do whatever looks good on the camera.

2. Connect the camera to the computer
If using a firewire camera, make sure everything is turned off before connecting it
together; cameras have been known to catch fire when being connected to a
computer while turned on (this is nothing to do with the name).

If using USB, make sure the drivers for the camera are installed before connecting the
camera.

3. Turn on the computer (and camera) and launch the animation software



How to Animate (using the software)

1. Configuring the software
There are accompanying videos on the Crux web site which provides a visual
explanation of how to set up the recommended software, and mirrors the explanation
given below. Explanations are given for the software SMA (PC) and iStopMotion
(Mac). If you are using different software, the following configurations are
recommended:

Photos are taken with a resolution of 640 pixels wide by 480 pixels high
Videos are played back at a frame rate of 15 photos per second

These configurationswill need to be made every time a new animation is begun.

In SMA:

- Launch the Stop Motion Animator Software. Two windows should appear
which will looking something like this.

The SMA Software

- To configure the software to the correct specification, in the ‘Animator’
Window; click on the ‘Options’ menu and select ‘Capture Options...’ from the
menu which appears. This should open a new ‘Capture Options’ window.

- Make sure that in this window, these options have been selected:

Movie will run at 15 fps.
Grab 1 frames at a time.

- In the top-right hand corner of this window, click on the ‘Video Format...’
button. This should cause another window to launch with the titled ‘Video
Format’. The ‘Stream Settings’ tab should be selected. In this tab, change the
resolution to be ‘640 x 480’.

- Click on ‘OK’ in the ‘Video Format’ window and click ‘OK’ in the ‘Capture
Options’ window.



- Click on the ‘Special’ menu in the ‘Animator’ window. Select ‘Video Window
Size...’ from this menu. A ‘Video Window Size’ menu should appear; in this
window change the ‘Size in Pixels’ to have a width of 640 and a height of 480.
Click on ‘OK’.

In iStopMotion:

- Launch iStopMotion. A window which looks similar to the following should
appear.

Set Up Window in iStopMotion

- In the ‘Width’ field, type ‘640’ as the number of pixels wide and in the ‘Height’
field, type ‘480’ as the number of pixels high.

- Change the number in the ‘FrameRate’ field to ‘15’ frames per second.

- Make sure that the timecode is starting from ‘00:00:00:00’; this is the default
value.

- Click on ‘OK’. A video window should open and the video images being sent
from the camera should appear on the screen.

- If the video images do not appear, click on the camera icon to the right of the
video control buttons and select the desired camera from the list which
appears. If the camera does not appear in the list, close iStopMotion, turn the
camera off and then back on again and then follow the previous instructions to
set up iStopMotion again.

For further assistance, visit http://www.istopmotion.com.

Camera List in iStopMotion



2. Framing
Framing refers to how the models are positioned in the camera shot. Framing is very
useful in telling stories using images; using different types of camera shots will create
different atmospheres and make the story more interesting. This is true for both film,
picture story books and comic strips.

Here are some examples of how models can be framed in a shot:

A Wide Shot

Wide Shot
Useful for setting the scene and putting characters and models into the context of
their situation. Often used at the start and end of a scene.

A Mid-Shot

Mid or Half Shot
Standard shot for filming news readers, sometimes known as a ‘Head and Shoulders
Shot’. Can be used to establish relationships between people; if someone is being
looked down upon they appear to be inferior,whereas if the camera is looking up at a
character,they appear to be superior or stronger.



A Close Up

Close Up
Used to convey emotion or something personal.

In each of these shots, the character has been positioned so that the eyes/face is
about 2/3 of the way up the frame and the character is roughly central. This does not
have to be the case, though is often quite aesthetically pleasing. Remember when
framing a shot to keep the models in focus.

3. TakingPhotos

In SMA:

- In the ‘Animator’ window, click on the ‘Start’ button to begin the animation.
Clicking on ‘Start’ will automatically capture the first frame of the animation.
After the first frame has been captured, the ‘Start’ button changes it’s name to
become the ‘Grab’ button.

- To capture subsequent frames, click on the ‘Grab’ button. Clicking on ‘Grab’
will always put frames at the end of the animated sequence, regardless of
where the arrow is in the timeline.

NOTE: Once a frame has been captured, it cannot be deleted directly within
the SMA software. Unwanted frames can only be removed in the editing
process and can be tricky to do; it is best to take the shot right the first time.

- Frames can be reviewed by clicking on the timeline strip in the ‘Animator’
window. The arrow on the timeline shows the frame currently being viewed,
with reference to the other frames in the timeline. The reference number of the
current frame being viewed is also displayed in the black box above the
timeline (the number above). The number below this is the total number of
frames in the timeline.

- The timeline can be navigated using the controls below the timeline. Using
these controls, the animation can be rewound to the beginning, skipped
forward to the end, moved back or forward one frame at a time and played as
normal. Clicking on the ‘loop’ button can also loop the animation.



Controls in SMA

- At any point, to return to the live camera image, click on the ‘Live’ button in
the animator window.

Onion Skinning
It maybe useful to be able to see how larger movement is being made between
frames, before taking the photo. This can be done by clicking on the ‘Onion
Skin’ button at the bottom of the animator window.

The onion skin facility displays the last photo taken, and overlays on top of it,
the photo which is about to be taken. The difference between the two pictures
should be visible.

In iStopMotion:

- Taking photos in iStopMotion is very easy; click on the ‘record’ button
beneath the video image in the iStopMotion window. This will add a photo to
the timeline below the video controls, at the current location of the timeline
playhead.

- Multiple photos can be taken at once by pressing the number keys on the
computer keyboard; ‘1’ to take one photo, ‘2’ to take two photos, etc. up to ‘4’.



- Note that the photo about to be taken is overlaid onto the photo just taken so
that the difference between the two photos can be clearly seen. This is
referred to in iStopMotion as ‘PreviewOverlay’.

- Footage can be reviewed by using the video controls. Much like a DVD player,
the timeline can be skipped to the beginning or end, or checked through one
frame at a time. The footage can be played through to ensure that the
animation is looks as it should.

- Photos will be added into the timeline where ever the playhead currently is in
the timeline; remember that after footage is reviewed, to return the playhead
to the end of the timeline before continuing to animate.

- If a frame is taken accidentally, or is incorrect, it can be deleted by selecting
the frame at issue in the timeline and pressing the ‘backspace’ key while
holding the ‘apple’ key on the computer keyboard. This should remove the
offending frame from the timeline.

4. Moving the Models
Remember, for every second of footage that you require, you will need to take 15
photos. Act through the motion you are animating as you move the model; think about
how long it takes you to perform the action and how many frames you will need to take
in order to make your animation perform the same action, and how small the
movements you need to make should be.

Time to perform action (seconds) x FrameRate = Number of frames to be taken

e.g. 1 x 15 = 15 frames

If using the recommended frame rate (15 frames per second) then:

1 frame 1/15th second

Time Number of frames to be taken
1/2 second 8 frames
1 second 15 frames
2 seconds 30 frames
5 seconds 75 frames
10 seconds 150 frames
20 seconds 300 frames
30 seconds 450 frames
60 seconds 900 frames

5. Saving the Animation

In SMA:

- When all of the required frames have been captured, click on the ‘Done’
button in the animator window. This will automatically open a ‘Save File As’
dialogue box.

- Select the location to save the animated sequence and give the file a name.
Click on the ‘Save’ button to save the sequence. Files produced by SMA are
always AVI movie files. These can be played back using most video viewing



software, such as Window Media Player, and are supported by most operating
systems.

In iStopMotion:

- From the ‘File’ menu at the top of the screen, select ‘Save’. If this is the first
time that the animation has been saved, a window will appear asking that the
animation be given a name and for the location which it is to be saved into, to
be selected. When this has been done, click on the ‘Save’ button in the bottom
right of the window.

- Remember to save your animations regularly to preventwork being lost.

- When an animation has been completed, it needs to be exported ready to be
edited. This is done by selecting ‘Export to DV...’from the file menu.

- A window should appear asking that the exported movie file be given a name
and to select the location that the movie is to be saved into. When this has
been done, click on the ‘Save’ button in the bottom right of the window.



Practice Exercises
The best way to learn is by doing; have a go at some of these practice exercise to
become familiar with setting up the software, animating a sequence and exporting it
into a video file to be edited.

1. The Race
Get two objects and make them race across a table top so that they
are moving smoothly, but at different speeds. The whole race should
last between 10 and 15 seconds (150 to 225 frames).

2. The WickedWitch
Get a piece of plasticine and animate it ‘melting’ into a plasticine
puddle. Then try 'morphing' the plasticine puddle into a character.The
whole sequence should last between 5 and 10 seconds (75 to 150
frames).

3. Walking the Walk
Using either a toy with moveable legs, or a plasticine model with legs,
practice making it move across the screen using it’s legs. The whole
sequence should last between 5 and 10 seconds (75 to 150 frames).

4. Miracle-Grow
Animate a plasticine tree growing out of a table top. The sequence
should last up to 15 seconds (225 frames).



The Basics of Editing
Usually each shot in an animated scene should be saved as a different video file.
When this has been done, the shots can be put together into a single film, in a process
called ‘Editing’. The editing process also includes tasks such as adding transitions,
effects, audio and titles to the film, enhancing the film and helping to tell the story.

1. Starting a Project & Import Clips

In Windows MovieMaker:

- LaunchWindows Movie Maker.

- On the left hand side of the screen is almost a step-by-step guide to editing
video in Windows Movie Maker.The first step is to import the animated footage
into Movie Maker.This is done by clicking on the ‘Import Video’ link, under the
heading that reads ‘1. Capture Video’.

- An ‘Import Video’ dialogue window should appear. In this window, locate the
animated clips that are to be imported and click on the ‘Import’ button.

- These clips are imported into a ‘collection’, that is, a folder within WMM. Each
time more clips are imported, a new collection is created. The collections can
be viewed and selected by clicking on the ‘Collections’ menu list, just below
the menu bar at the top of the screen.

- In the same way,still images and audio trackscan be imported.

In iMovie:

- Launch iMovie. Usually the last project that was worked on in iMovie will be
automatically loaded. If this is the case, close the open project. If the last
project worked on can not be found, or iMovie is being launched for the first
time, a window will appear similar to the one shown here. Ignore this window to
begin with.

iMovie Start Screen

- From the menu bar, select ‘iMovie’ and from the menu which appears, select
‘Preferences’.

- Another window should appear entitled ‘Preferences’. Depending on which
version of iMovie is being used, this step will vary. An option needs to be



selected to say that new projects being created are ‘PAL’ format (rather than
NTSC), or if iMovie HD is being used, that new project frame rate is 25 frames
per second (rather than 29.97 frames per second). This step need only be done
once; it is a necessary step to ensure that the edited film will play on UK
televisions.

- Close the preferences window. In the iMovie window, click on the ‘Create a
New Project’ button.

- A window will appear asking where to create the new project. Select the
location where the project is to be saved and give the project a name.

- Towards the bottom of the window is an option which allows the video format
to be set. Select ‘DV’ as the video format. Click on the ‘Create’ button.

- A window should appear,similar to the picture shown in here.

An iMovie Project

To Import Clips into iMovie:
- From the menu bar, select ‘File’ and from the menu that drops down, select
‘Import...’.

- A window will appear showing the disks available to the computer; locate the
animations to be added into the project, select them and click on the ‘Open’
button. Repeat this step if there are more clips to be imported from a different
location.

- The computer should copy the clips into iMovie. These clips should appear in
the clips library on the right hand side of the iMovie window.



2. Adding Clips to a Timeline

In Windows MovieMaker:

- There are two views for the timeline in WMM; the ‘storyboard’ view and the
‘timeline’ view.The two views can be toggled between by clickingon the ‘Show
Timeline’ button in the storyboard view, or on the ‘Show Storyboard’ button in
the timeline view.These buttons appear just above the timeline.

- Clips from collections can be dragged and dropped from the central part of
the WMM window, into either of these timeline views to add them into the
timeline.

In iMovie:

- There are two views for the timeline in iMovie; the ‘timeline viewer’ and the
‘clips viewer’. These two views can be toggled between by clicking on the
timeline buttons shown here. These buttons can be found just above the
timeline on the left-hand side of the iMovie window.

The Timeline/Clips View Buttons in iMovie

- Click on the required clip within the clips library on the right-hand panel of the
iMovie window, and drag it on to the timeline at the bottom of the iMovie
window. Release the mouse button; the clip should disappear from the clips
library and appear in the timeline.

- In the same way, clips in the timeline can be moved back into the clips library
window, or rearrangedwithin the timeline.

3. Top& Tailing
Top and tailing is a term which describes cutting the beginning and end off of a clip so
that it fits more appropriately into an edited sequence. It may also be useful for cutting
out unwanted frames from an animated sequence.

In Windows MovieMaker:

- The start and end points of an animated clip can be changed once it has been
dropped into the timeline.

- Click on the ‘Show Timeline’ button to show the film as a timeline.

- Click on the clip that is to be edited. A black box should appear around the
inside of the selected clip, with an arrow appearing at each end.



- Moving your mouse above these arrows will change the cursor into a red,
double ended arrow.Click and drag the ends of the selected clip to set the new
start and end points.

- To remove an individual frame from a sequence, drag two copies of an
animated clip onto the timeline. Move the end of the first copy of the clip so that
it ends just before the unwanted frame, and move the start of the second clip
so that it begins just after the unwanted frame. When the whole sequence is
played back, the unwanted frame should be hidden in the timeline.

In iMovie:

- Click on the clip in the clips library which is to be top and tailed, to load it into
the viewing area in the iMovie window.

- Click on the playhead at the bottom of the viewing screen and drag it to the
position in the clip where the clip should begin.

- In the menu bar, select ‘Edit’ and from the menu which appears, select ‘Split
Video Clip at Playhead’, or alternatively press ‘T’ while holding down the
‘apple’ key on the computer keyboard.

- The clip in the clips library should become two clips; the first one of these is
the start of the video (before the video split) and the second is the end of the
video (after the video split).

- Reposition the playhead at the bottom of the viewing screen to the desired
end point of the clip. Again, select ‘Edit’ and then ‘Split Video Clip at Playhead’
to split the video. There should now be three clips in the clips library, the
middle clip of which should be piece of video which has been top and tailed.

- If the top and tail of the clip are no longer needed, they can be deleted by
clickingon the clip in the clip library panel and pressing the ‘backspace’ key on
the computer keyboard.Watch the clips before deleting them to make sure that
something which is needed isn’t going to be deleted.

4. Adding Transitions
A transition is a way of making a change between two shots. They can be useful in
telling a story, or making the changes between scenes more interesting or obvious.
The most common transitions are ‘cuts’ where one shot jumps from the end of one
shot to the start of the next shot with no other motion in between, or ‘dissolves’ where
the outgoing shot fades into the next incoming shot.

In Windows MovieMaker:

- Under the '2. Edit Movie' menu on the left-hand side of the screen, click on the
'View video transitions' link. This will display various transitions which can be
applied between clips in the central area of the WMM window.

- The transitions can be previewedby double-clickingon each of the transitions
in the central area. An example of what the transition will look like should be
shown in the previewarea on the right of the screen.

- When an appropriate transition has been found, it can be applied between
two clips by dragging it into the small box between each of the clips in the
'storyboard view' of the timeline.



- Transitions can be removed from the timeline by right-clicking on the
transition box between the clips on the timeline and selecting 'Delete'.

In iMovie:

- Adding Transitions in iMovie will vary depending on the version of iMovie
being used. In iMovie HD, click on the ‘Editing’ button, just above the timeline
on the right of the screen. This will change the panel above it. In this panel,
click on the ‘Transitions’ tab at the top of the screen.

- A list of possible transitions will appear as a list in the right-hand panel. These
transitions can be previewed by clicking on each of them in turn and viewing
how the transition will look in the main viewing area of iMovie.

- When the desired transition has been identified, the speed at which the
transition occurs needs to be set. Click and drag the speed slider at the bottom
of the list of transitions, or type the number of frames into the speed field, over
which the transition should take place. The new speed can be previewed in the
main viewing window.

- When the desired transition and speed have been chosen, click and drag the
name of the transition onto the timeline between two clips. A new piece of
video should appear between the two clips; this is the transition.

- Watchover the transition to make sure that it appears as expected.

- If a transition is no longer required, click on the piece of video in the timeline
which represents the transition, so that it is highlighted in blue, and press the
backspace key on the computer keyboard. The transition should disappear and
the clips returned to as they were before the transition was applied.

5. Adding Effects
An effect is something that can be applied to a video clip to change the way it looks.
These changes maybe to do with the colours of the video image, the size, the speed,
the perspective or adding something new to the clip. Using effects on video clips can
create a different feel to the video and can be used to enhance or even tell the story
being presented.

In Windows MovieMaker:

- There are numerous effects that can be added to clips in the timeline to give
the animations a different feel and can be used to enhance the story being
told.

- Under the heading ‘2. Edit Movie’, click on the ‘View video effects’ link. This
will display the available effects in the central section of the screen.

- Effects can be previewed before applying them to a clip by double-clickingon
the effect in the central section of the screen. This will display what difference
the effect makes to the a clip in the preview display on the right-hand side of
the screen.

- When an appropriate effect has been found, it can be applied to a clip by
dragging and dropping the effect from the central section of the WMM window,
onto the desired clip on the timeline.



- Effects can be removed by right-clicking on the clip which is to have the
effects removed, and selecting 'Video Effects...' from the menu which appears.
This will launch a window entitled 'Add or Remove Video Effects'.

- In the right-hand column of 'Displayed effects:', select the effect which is to
be removed and click on the 'Remove' button between the two columns.

- In the same way, effects can be added to the clip by selecting the desired
effect in the left-hand 'Available effects:' column and clicking on the 'Add'
button between the two columns.

- When only the desired effects to be applied to the clip appear in the right-
hand column, click on 'OK' at the bottom of the window.

In iMovie:

- Adding Effects in iMovie will vary depending on the version of iMovie being
used. In iMovie HD, click on the ‘Editing’ button, just above the timeline on the
right of the screen. This will change the panel above it. In this panel, click on
the ‘Video FX’ tab at the top of the screen.

- The panel below should change to display a list of effects that can be applied
to the clips. In the timeline, click on the clip which the effect is going to be
applied to.

- From the list of effects, select an effect by clicking on it’s title. A preview of
how this effect will change the look on the clip can be seen in the viewing area
of iMovie.

- Some effects will have parameters which can be altered to change how the
effect will affect the clip. These appear beneath the list of effects in the right-
hand panel. Set the parameters so that the clip previewappears as required.

- When the desired effects and parameters have been chosen, click on the
‘Apply’ button in the bottom right-hand corner of the effects panel. The video
clip should render (a red box will appear at the bottom of the clip in the
timeline) and then whenever the clip is played back, should have the chosen
effect applied to it.

- Multiple effects can be applied to a clip at once by selecting another effect
from the effects list, adjusting the parameters and clicking on the ‘Apply’
button again.

- All the effects applied to a clip can be removed by either selecting ‘Undo
Apply Effect’ from the ‘Edit’ menu, just after an effect has been applied, or by
holding down the ‘Ctrl’ key on the computer keyboard and clicking on the clip
which is to have the effects removed from in the timeline. A menu should
appear above the clip; select ‘Revert Clip to Original’ from this menu and the
clip should return to how it looked initially.

6. Adding Titles
Titles can be useful for introducing a story, adding credits to the ends of films or
helping to establish a story. A title is any text which is applied to a video clip in the
editing process, and sometimes titles can be as interesting as the films themselves in
terms of creativity and style.



In Windows MovieMaker:

- Under the '2. Edit Movie' menu on the left-hand side of the screen, click on
the 'Make titles or credits' link. This will display a list of types of credits which
can be applied to the film. Follow the tutorial to add titles to the edited film. To
return to the main menu at any point, click on the 'Cancel' link.

In iMovie:

- Adding Titles in iMovie will vary depending on the version of iMovie being
used. In iMovie HD, click on the ‘Editing’ button, just above the timeline on the
right of the screen. This will change the panel above it. In this panel, click on
the ‘Titles’ tab at the top of the screen.

- The panel below should change to display a list of ways in which titles can
appear onto the screen. From this list, select one of the titles. Similarly to the
video effects panel, a list of parameters should appear beneath the list of
titles. A preview should play in the video viewing area of iMovie, showing how
the title will appear at present.

- In the text field beneath the list of titles, type the text which is to appear in the
video, and adjust the parameters for the text to change the size, font, colour
and speed at which the title occurs. A preview should appear in the viewing
area of iMovie, as the parameters are altered.

- When the desired title and parameters have been chosen, drag the playhead
in the timeline to the place where the title should be inserted into the film.

- In the bottom right-hand corner of the titles panel, click on the ‘Add’ button.
The title should be placed into the timeline and will automatically be rendered.
The title can then be played back as a video clip in the timeline.

- If at any point, the title needs to be altered, click on the title clip in the
timeline so that it is selected in blue. The title panel should appear on the
right-hand side of the iMovie window. Make the appropriate changes and then
click on the ‘Update’ button at the bottom of the title panel. The title should be
re-rendered, and so can be played back as part of the timeline.

- If a title is no longer required, it can be removed from the timeline by clicking
on it in the timeline so that it is selected in blue, and pressing the ‘backspace’
key on the computer keyboard. The title should disappear from the timeline,
which will return as to how it was before the title was applied.

7. Adding Sound and Music
In Windows MovieMaker:

- In the same way in which video clips can be imported into a collection, click
on the 'Import audio or music' link under the '1. Capture Video' menu on the
left-hand side of the screen. Locate the music or audio files to be imported
and click on the 'Import' button in the bottom right-hand corner of the import
window.

- Audio can be added into the timeline within the 'timeline view' of the edited
film. Drag and drop the audio files from the collections area in the central part
of the WMM window, onto the 'Audio/Music' line beneath the video timeline.



- Audio can be repositioned by dragging the audio clip to the left or right.

- Audio clips can be deleted by right-clicking on the audio clip in the timeline
and selecting 'Delete' from the menu which appears.

In iMovie:

- Adding audio in iMovie will vary depending on the version of iMovie being
used. In iMovie HD, click on the ‘Media’ button, just above the timeline on the
right of the screen. This will change the panel above it. In this panel, click on
the ‘Audio’ tab at the top of the screen.

- A list of titles should appear beneath this tab; each of these titles is a
location where some sound effects or music tracks are stored. Clicking on
each of these titles will display another list below, of the audio files available
in that location.

- These audio files can be played by double-clickingon the title of each file.

- When an appropriate audio clip has been found for the film, move the
playhead along the timeline to the place where the clip should begin. Click on
the ‘Place at Playhead’ button at the bottom of the audio panel on the right-
hand side of the iMovie window. The audio clip should be placed onto the
timeline.

- The audio clip can be repositioned by clicking and dragging the clip along
the timeline. Audio clips can be shortened in length by dragging the ends of
clip on the timeline.

- An audio clip can be removed by selecting it in the timeline and pressing the
‘backspace’ key on the computer keyboard.

- If the computer being used has a built-in microphone, a narration can be
added to the video by placing the playhead at the beginning of the clip to be
narrated and clickingon the record button within the audio panel on the right-
hand side. This will record audio from the microphone into a new audio clip on
the timeline.

NOTE: Be aware of copyright laws regardingmusic. Most pieces of music being used
in a school for educational purposes maybe used without explicit permission, so long
as they are not widely distributed and not sold for profit. If a video is being distributed
on DVD or on the internet, it advised to look into the rules regarding copyrighted
music. For more information on music copyright, visit:

http://www.mcps-prs-alliance.co.uk

8. Exporting the Video
Once a video has been edited, it needs to be exported into a final movie file so that it
can be distributed, either onto a DVD or put onto the web or so that it can be viewed
on a computer with out having to use the editing software.

In Windows MovieMaker:

- Under the '3. Finish Movie' menu on the left-hand side of the screen, click on
the 'Save to my computer' link. This should launch a wizard which takes the
user through the exporting of an edited video.



- Enter a name for the finished video and select a location into which it will be
saved. When this has been done, click on the 'Next' button at the bottom of
the wizard window.

- On the next page of the wizard, select the 'Other settings:' radio button, and
from the drop down list to the right, select 'DV-AVI (PAL)'. Click on the 'Next'
button at the bottom of the wizard window. The edit video should export into a
stand-alone file which can be played back using Windows Media Player.

In iMovie:

- In the ‘File’ menu at the top of the screen, select ‘Export...’. A window
should appear displaying the methods by which the edited film can be
exported.

- Click on the ‘QuickTime’ button at the top of the window. In the panel which
appears beneath, click on the drop-down menu next to the text which reads
‘Compress movie for:’. From the list of quality options given, select ‘Full
Quality’.

- Click on the ‘Share’ button in the bottom right-hand corner of the window. A
‘Save’ dialogue should appear.Give the film being saved a name and specify
the location as to where the film should be saved.

- Click on the ‘Save’ button. The film should be exported and a movie file
should appear in the location specified. This is the final movie file which can
be viewed using the QuickTime Player.



Workingwith YoungPeople and Technology: Some Pointers

- Many young people will be quite familiar with using a computer and with the
theory of animation; most of them will just want to get on with it.

- Many young people, once they get the hang on animating will get quite
enthusiastic about capturing images using the computer and will accidentally
get their hands in the shot. Try to encourage them to take their time and make
sure their hands are well away from the model before taking a photo.

- When animating for the first time, students may make the movements of
models between photos too large, causing the animations to be very jumpy
and quite short. Try to encourage the students to make very very small
changes to their models between photos; remember,every second of footage
requires 15 photos.

- Assume that the first few animations that the students produce are not going
to be very good. Try to encourage them and point out what they are doing
right as well as what they need to improve on. Don’t be afraid to take the time
to help them develop a good skill in animation; it’s better to have a few good
skills than half a dozen sloppy ones.

- Don’t try to cram too much into the sessions; take your time in order to let
the young people develop their skills. Make sessions flexible; it doesn’t matter
if something spills over into the following session.

- Make sure everything works before hand...literally everything. Assume
nothing will just work without it having to be fiddled with first!

- Assume that everything that can go wrong will go wrong. Be prepared to
know how to solve problems and what to do if a problem can’t be solved.
Always have a plan B that doesn’t involve a computer; maybe model making
(Session 1) or story-boarding (Session 3).

- If the students are enjoying themselves, let them carry on; don’t force them
to move on if they aren’t ready, though also don’t let them spend too long on
something that is only a small part of the course.

- Keep plasticine off the floor; it’s difficult to get out of carpet once trod on
and can sometimes stain fabric.

- When teaching, use examples of animations to demonstrate what you are try
to explain. There are some examples on the Crux web site.

- Chat with the students as they work; ask them about their ideas for
animations so as to clarify in their own minds what they are going to do.

- Keep smiling no matter what happens.


